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第1章  约 束 草 图


第1篇  设 计 进 阶

第1章  约 束 草 图

【目的】

本章描述了建立与修改草图约束。

在完成本章学习之后，读者将能够：

· 创建直接草图。

· 自动建立并显示约束。

· 利用约束建立关系。

· 约束草图周长。

· 使用可视化动画显示草图。

· 利用定位尺寸进行草图定位。

1.1  直 接 草 图

直接草图（Direct Sketch）工具条在建模环境中可用。运用该工具条上的命令可以创建平面上的草图，无须进入草图任务环境中。

当使用直接草图工具条上的命令创建点或线时，系统将建立一个草图并将其激活，新草图出现在部件导航器中的模型历史树下，指定的第一个点即定义了草图平面、方向和原点。

可以采用下面的方式定义第一个点：

· 屏幕位置。

· 点。

· 线。

· 面。

· 平面。

· 边。

· 指定平面。

· 指定基准坐标系。

直接草图工具只需少量的鼠标单击操作，就可以快速、方便地创建和编辑草图。

在创建和重附着草图时，NX会自动创建中间基准坐标系（Intermediate Datum CSYS）。默认情况下，中间基准坐标系属于草图内部特征，在草图外部和部件导航器（PNT）的模型历史树下是不可见的。

选择Create Intermediate Datum CSYS选项，可以关联中间基准坐标系到草图建立的基本特征。该选项同时给予草图独立性，所以在删除基本特征时，草图能够保留。

可以对中间基准坐标系进行如下操作：

· 在部件导航器中右击草图特征节点，在弹出的快捷菜单中选择Make Datums External命令，在草图外部显示基准坐标系。

· 在部件导航器中右击草图特征节点，在弹出的快捷菜单中选择Make Datums Internal命令，在草图内部包含基准坐标系。

【练习1-1】  快速草绘和创建模型
本练习将直接在建模环境中创建和拉伸草图轮廓，如图1-1和图1-2所示。

· 运用Direct Sketch工具条创建直接草图，无须进入草图任务环境。
· 使用Extrude命令，无须退出草图，NX会自动选择草图。
[image: image1.emf]           [image: image2.png]



图1-1  创建的直接草图轮廓                    图1-2  拉伸草图轮廓生成实体

第1步  创建直接草图轮廓。

· 应用模型模板创建一个新的公制单位文件（mm）。

· 在Direct Sketch工具条上单击Profile按钮[image: image3.png]


（必要时在工具条空白处单击鼠标右键，选择Direct Sketch工具条）。

· 选择基准坐标系的原点，如图1-3所示。

· 沿着+X方向移动鼠标，当看到带箭头的虚线辅助线时单击屏幕位置，创建一条水平线，如图1-4所示。

[image: image4.png]


                   [image: image5.png]



 图1-3  选择基准坐标系的原点                  图1-4  沿+X方向创建水平线

· 沿着+Y方向移动鼠标，当看到带箭头的虚线辅助线时单击屏幕位置，创建一条竖直线，如图1-5所示。

· 移动鼠标单击屏幕位置，大致位置如图1-6所示。

[image: image6.png]


            [image: image7.png].
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图1-5  沿+Y方向创建竖直线                    图1-6  在屏幕某位置单击

· 沿着-X方向移动鼠标，当看到点辅助线时，单击屏幕位置，确保线的端点垂直于点辅助线，如图1-7所示。

· 选择基准坐标系的原点，形成封闭轮廓，完成草图曲线绘制，如图1-8所示。

[image: image8.png]


         [image: image9.png]



图1-7  创建沿-X方向水平线                    图1-8  完成草图轮廓绘制

第2步  拉伸直接草图轮廓。

· Direct Sketch工具条仍处于激活状态下，单击Extrude按钮[image: image10.png]


，NX会自动选择刚才创建的草图轮廓作为拉伸截面线，如图1-9所示，拉伸距离不限。

· 单击拉伸对话框中的OK按钮，创建实体，如图1-10所示。

[image: image11.png]


                 [image: image12.png]



图1-9  拉伸直接草图轮廓                         图1-10  创建实体

【练习1-2】  基于CSYS创建直接草图

在本练习中，读者将学会：

· 基于中间基准坐标系创建直接草图。

· 删除直接草图附着面，观察中间基准坐标系的变化。

· 重附着直接草图，观察中间基准坐标系的变化。

第1步  打开部件\Parts_1\C1\intermediate_csys.prt，如图1-11所示。

第2步  基于中间基准坐标系创建直接草图。

· 在Direct Sketch工具条上单击Sketch按钮[image: image13.png]


。

· 在Create Sketch对话框的Type下拉列表中选择On Plane选项。

· 在Settings组中选中Create Intermediate Datum CSYS复选框，如图1-12所示。

[image: image14.png]
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图1-11  intermediate_csys.prt                     图1-12  Create Sketch对话框

· 选择图1-13所示面，作为直接草图绘制平面。

· 在Direct Sketch工具条上单击Circle按钮[image: image16.png]


，在拉伸特征的面上创建圆，如图1-14所示。

[image: image17.png]


               [image: image18.png]



  图1-13  选择草图绘制面                     图1-14  创建直接草图曲线

· 在图形工作区上单击鼠标右键，从弹出的快捷菜单中选择Finish Sketch命令，完成直接草图的创建。

第3步  删除直接草图的父特征，观察草图变化。

· 在部件导航器中新建的草图节点sketch_002上单击鼠标右键，在弹出的快捷菜单中选择Make Datums External命令。中间基准坐标系（Intermediate Datum CSYS）会显示在部件导航器和图形工作区中，如图1-15所示。

· 在部件导航器中的Sketch_002上单击鼠标右键，并在弹出的快捷菜单中选择Make Datums Internal命令。基准坐标系被隐藏，成为草图内部特征。

· 在Extrude(3)上单击鼠标右键，并在弹出的快捷菜单中选择Delete命令，再在弹出的Notification对话框中单击OK按钮，忽略信息窗口，观察草图变化，如图1-16所示。

[image: image19.png]
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图1-15  显示的中间基准CSYS                    图1-16  信息提示窗口

[image: image21.emf]
注意：由于直接草图位于中间基准坐标系上，因此拉伸特征的删除对草图没有影响，草图还保留在原位。

第4步  重附着草图到滑轮面上。

· 在草图上单击鼠标右键，并在弹出的快捷菜单中选择Edit命令[image: image22.png]


。

· 选择Tools→Reattach Sketch命令。

· 选择滑轮面并单击OK按钮，观察草图变化，如图1-17所示。

[image: image23.png]



图1-17  重附着草图到滑轮面上

[image: image24.emf]
注意：NX保留已存在的中间基准坐标系，且附着草图到滑轮面上。

· 关闭部件。

1.2  自 动 约 束
自动约束（Auto Constrain）命令用来建立NX可自动识别的多种几何约束类型到选择的草图对象。基于命令设置，分析选择的几何体，添加约束到草图。

当添加几何体到激活的草图时，特别是那些从不同的CAD系统读入的几何体，此命令将特别有用。另外也可以利用此命令添加单个约束类型到多个草图对象。例如，添加一个相切约束到多个圆角与它们的相邻曲线。

在Direct Sketch工具条上或者草图任务环境中的Sketch Tools工具条上，单击Auto Constrain按钮[image: image25.emf]，或选择Tools→Constraints→Auto Constrain命令，打开Auto Constrain对话框，如图1-18所示。
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图1-18  Auto Constrain对话框

自动约束选项描述如表1-1所示。

表1-1  自动约束选项

	选    项
	描    述

	Curves to Constrain（要约束的曲线）
	选择需要添加约束到其上的草图曲线

	Constraints to Apply（要添加的约束）
	列出能添加到所选曲线的有效几何约束

	Set All（设置所有）和Clear All（取消所有）
	可以用于打开或关断所有约束类型

	Apply Remote Constraints（添加远程约束）
	允许在实际不接触的曲线间自动建立约束

	Distance Tolerance（距离公差）
	该选项用于闭合在共点约束类型间的间隙，如重合与同心

	Angle Tolerance（角度公差）
	当选择水平、垂直、平行和正交自动建立选项时使用


自动约束操作步骤如下：

（1）在Sketch Tools工具条上单击Auto Constrain按钮[image: image27.emf]。

（2）可选项：在选择对话框选项前，单击Set All按钮或单击Clear All按钮。

（3）在Constraints to Apply列表中选择要添加到草图的约束类型。
（4）在Settings组中，设定恰当的Distance Tolerance和Angle Tolerance值。

（5）选择要添加约束的草图曲线。
（6）单击OK按钮。

自动约束对话框中的Set All（设置所有）和Clear All（取消所有）按纽可以用于打开或关闭所有的约束选项。

当使用Horizontal（水平）、Vertical（垂直）、Parallel（平行）和Perpendicular（正交）自动创建选项时，系统使用设定的角度公差来评价直线并建立正确的约束。

自动约束的其他类型，如Coincident（共点）和Concentric（同心），使用距离公差来建立约束。

共点约束的距离公差将影响封闭间隙。这个条件和从其他系统转换来的条件是一致的。

Apply Remote Constraints（添加远程约束）选项可用于在实际不接触的曲线间创建自动约束。通常支持延伸相切的曲线。

【练习1-3】  自动创建约束

[image: image28.emf] 设计意图：本例中假设他人已生成的约束不合理，且存在模糊问题。因草图相对简单，可以删除所有的约束，并用新约束代替它们。自动约束可大大提高操作效率。
第1步
打开\Parts_1\C1\pipevise.prt，启动建模应用模块。

第2步
选择Preferences→Modeling命令，在弹出对话框的Edit选项卡中设置Edit Sketch Action为Task Environment，单击OK按钮，如图1-19所示。

第3步  双击任一草图曲线，激活草图s21_profile，如图1-20所示。
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图1-19  Modeling Preferences对话框                图1-20  激活的草图s21_profile
第4步  利用Show/Remove Constraints分析和移除已有的约束。

· 在Sketch Tools工具条上单击Show all Constraints按钮[image: image31.png]


。

· 单击Show/Remove Constraints按钮[image: image32.png]


。

· 在List Constraints for组中选中All In Active Sketch单选按钮。
· 在Show Constraints下拉列表中选择Both选项，如图1-21所示。

· 利用Step箭头遍历已存几何约束，查看各个约束关系。

· 单击Remove Listed按钮。
· 单击OK按钮。
第5步  利用Auto Constrain添加某些约束类型到草图，设置对话框如图1-22所示。
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  图1-21  Show/Remove Constraints对话框               图1-22  自动约束设置对话框

单击Auto Constrain按钮[image: image35.png]


。

· 在图形窗口中选择所有草图曲线。

· 单击Clear All按钮。

· 在Constraints to Apply组中选中Horizontal、Vertical、Tangent和Coincident复     选框。

· 在扩展Settings组中，设置Distance Tolerance为0.001。

· 单击OK按钮。
第6步  在基准轴和垂直、水平草图曲线间建立共线约束。

单击Constraints按钮[image: image36.png]D



。

· 选择左边垂直线以及垂直基准轴。

· 单击Collinear按钮[image: image37.png]N



。

· 选择底部水平线以及水平基准轴。

· 单击Collinear按钮[image: image38.png]N



。

第7步  对顶部两条水平线建立共线与等长约束。

· 按Ctrl键并选择顶部的两条水平线。

单击Collinear按钮[image: image39.png]N



和Equal Length按钮[image: image40.png]


。约束后的草图如图1-23所示。

[image: image41.png]p0=5.000





图1-23  约束后的草图

· 按Esc键关闭Constraints对话框。

第8步  为底部水平线和中间垂直线建立中点约束和点在曲线上约束。

· 按Ctrl键，选择底部水平线和竖直线的底部端点。

单击Midpoint按钮[image: image42.png]


和Point on Curve按钮[image: image43.png]


。

· 如图1-24所示，状态行将显示草图充分约束。
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图1-24  草图充分约束

第9步  退出草图任务环境。

单击Finish Sketch按钮[image: image45.png]


。
第10步  关闭部件。
1.3  周 长 约 束

周长约束（Perimeter Constraint）用来约束选择的草图轮廓曲线总长度到要求值。允许施加周长约束的曲线类型是直线和圆弧。

如图1-25所示，周长约束存储为由关键字Perimeter_为前缀的表达式。表达式的值是选择曲线的当前长度总和。与任一其他表达式相同，可以通过修改它的值去编辑周长表   达式。

[image: image46.emf]
注意：周长约束在图形窗口中不显示。不能转换周长约束为参考对象。  

单击建模环境的Direct Sketch→Dimensions列→Perimeter Dimension按钮[image: image47.png]


或草图任 务环境的Sketch Tools工具条→Dimensions下拉列表→Perimeter按钮[image: image48.emf]或选择Insert→Dimensions→Perimeter命令，将弹出如图1-26所示的Perimeter Dimension对话框。
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图1-25  周长表达式                      图1-26  Perimeter Dimension对话框
【练习1-4】  约束草图的周长

[image: image51.emf] 设计意图：如图1-27所示为游泳池的平面图，具体要求如下：

· 使两个较大半径相等，并由尺寸控制。

· 使4个拐角半径相等，并由尺寸控制。

· 周长必须是常量。

第1步  打开\Parts_1\C1\skt_perimeter.prt，启动建模应用模块。

第2步  选择Preferences→Modeling命令，在Edit选项卡中设置Edit Sketch Action为Task Environment，单击OK按钮，如图1-28所示，激活 SWIMMING_POOL草图。
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 图1-27  游泳池平面图                       图1-28  Modeling预设置对话框

第3步  使用Show/Remove Constraints功能查看已有的约束。
· [image: image157.png]


[image: image158.png]


单击Show/Remove Constraints按钮[image: image54.png]


。
[image: image159.png]


选中All In Active Sketch单选按钮。
· 设置Constraint Type为All。
· 设置Show Constraints为Explicit，如图1-29所示。 
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图1-29  查看已有约束

· 选择列表中的第一个约束 A5 Equal radius to A7，观察屏幕高亮显示的曲线。
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或使用向下箭头键，观察草图中其他已有约束的情况。

· 单击Cancel按钮关闭对话框。

第4步  约束草图的周长。
[image: image160.png]


在Inferred Dimensions列表中单击Perimeter按钮[image: image57.png]


。

· [image: image161.png]


在图形窗口中选择8条激活的草图曲线。
· [image: image162.png]


单击OK按钮。

第5步  编辑周长表达式从当前值到800.00。
· 在Part Navigator中选择Sketch (4)"SWIMMING_POOL"选项，扩展Details面板，如图1-30所示。

· [image: image163.png]


双击Perimeter表达式，输入800，并按Enter键确认。

· [image: image164.png]


观察在草图中发生的变化，如图1-31所示。
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 图1-30  编辑周长表达式                          图1-31  更新的草图
第6步  关闭部件文件。

1.4  控制冷却管中的热传递

【练习1-5】  控制冷却管中的热传递

[image: image60.emf] 设计意图：冷却管的冷却叶片横截面由管内液体的体积控制，每个叶片的周长应该等于横向流动截面周长的10倍，具体要求如下： 
· 使用一个周长尺寸来控制总周长。

· 叶片周长表达式等于冷却管横向截面周长的10倍。

第1步  打开\Parts_1\C1\perim_1.prt，如图1-32所示，启动建模应用模块。

[image: image61.png]



图1-32  perim_1.prt

该零件有以下特点：

· 冷却管外径由内径和壁厚确定。

· 冷却叶片长度由冷却管长度确定。

· 冷却叶片轮廓由其周长确定。

[image: image62.emf]
注意：通过Tools→Expressions命令来检查表达式areaRatio的内容。
第2步  利用Part Navigator和Expressions对话框来考察已有特征。

· 在Part Navigator中选择Extrude (2)和Sketch (3)"FIN"特征，如图1-33所示。
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图1-33  部件导航器

· 选择Tools→Expressions命令，打开Expressions对话框，找到命名表达式areaRatio，如图1-34所示。
· 关闭Expressions对话框。

第3步  利用Show/Remove Constraints考察FIN草图。
· 打开冷却叶片草图FIN，如图1-35所示。
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图1-34  Expressions对话框                        图1-35  冷却叶片草图

[image: image66.emf]
注意：该草图由两个约束定位，即参考曲线与61层上的基准轴（YC）共线以及圆弧与冷却管外径同心同半径。

当前草图还没有完全约束，状态行提示：Sketch need 1 Constraints。
第4步  添加周长尺寸约束到FIN草图。

· 使第1层不可见或消隐实体特征。
单击Perimeter按钮[image: image67.png]


。
· 选择在草图中激活的曲线，如图1-36所示。
[image: image68.png]
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图1-36  选择曲线

· 单击OK按钮。

· 在Part Navigator中，选择FIN草图并扩展Details面板。
[image: image70.emf]
注意：称为Perimeter Dimension Containing L4的新尺寸已生成，并且现在草图已经完全约束。
第5步  退出草图。

· 单击Finish Sketch按钮[image: image71.png]


，完成草图编辑。

第6步  拉伸草图。

· 在图形窗口中，在FIN草图上单击鼠标右键，在弹出的快捷菜单中选择Extrude命令[image: image72.png]


。
[image: image73.wmf]
提示：默认的拉伸方向与草图平面垂直，即+ZC方向，如图1-37所示。

[image: image74.png]



图1-37  默认的拉伸方向

· 双击End手柄，反转拉伸方向。
· 在End手柄上单击鼠标右键，在弹出的快捷菜单中选择Until Extended命令，如   图1-38所示。

· 选择冷却管底面作为Until Extended面，如图1-39所示，并选择Unite将拉伸实体相加。
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                [image: image76.png]



图1-38  选择Until Extended命令        图1-39  选择底面作为Until Extended面并求和
[image: image77.emf]
注意：如果布尔运算中目标只有一个实体，那么系统会自动选中该实体。

· 单击OK按钮。
第7步  创建拉伸冷却叶片的环形阵列。

· 使61层可选。
· 在Feature Operation工具条上单击Instance Feature按钮[image: image78.png]


。
· 单击Circular Array按钮。

· 选择特征Extrude(4)，然后单击OK按钮。

· 设置Number为8，Angle为360/8。

· 单击OK按钮。

· 单击Datum Axis，在图形区中选择垂直基准轴。
· 单击Yes按钮。

· 单击Cancel按钮。
· 除当前工作层外，其他层均设为不可见，如图1-40所示。

[image: image79.png]



图1-40  创建的环形阵列
第8步  捕捉冷却叶片的设计意图。

· 选择Tools→Expressions命令。
· 选中表达式ID，设置其值为0.75，并单击[image: image80.png]


按钮，然后单击Apply按钮，如图1-41（a）所示。
· 缩放（Fit）视图[image: image81.png]


，如图1-41（b）所示。
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（a）改变ID值                        （b）表达式ID为0.75时的冷却叶片
图1-41  捕捉冷却叶片

[image: image84.emf] 设计意图：冷却叶片保留了其原始轮廓，如果冷却管体积增加，则冷却叶片也要增加。表达式areaRatio是关于冷却叶片轮廓与冷却管截面积的关系。所以只要将该表达式与周长尺寸约束关联即可。

· 单击[image: image85.png]


按钮撤销上次表达式的修改。

· 选择周长尺寸表达式Perimeter_p22，设置其值为areaRatio，并单击[image: image86.png]


按钮，然后单击Apply按钮，如图1-42（a）所示。

[image: image87.emf]
注意：可以发现冷却叶片变短了。实际上，用户需要调整公式，以达到精确的设计要求。
· 选中表达式ID，设置其值为0.875，并单击[image: image88.png]


按钮，然后单击OK按钮，退出表达式对话框。

· 缩放（Fit）视图，如图1-42（b）所示。
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    [image: image90.png]



（a）改变ID与Perimeter值                        （b）更新后的冷却叶片
图1-42  更新冷却叶片
[image: image91.emf]
注意：冷却叶片已按公式要求更新了。

第9步  关闭Part文件。

草图约束允许捕捉和维护设计意图。通过尺寸和约束，可以使实体模型满足最后产品的设计意图。

1.5  草图——动画尺寸
动画尺寸（Animate Dimension）命令用来动态显示给定尺寸在指定范围内改变的效果。受选择尺寸影响的所有几何体也将一起显示动态改变过程。

[image: image92.emf]
注意：与拖拽不同，动画尺寸不改变草图尺寸值。当动画完成时，草图返回它的原     状态。

通过Modeling环境中的Direct Sketch→Animate Dimension按钮[image: image93.emf]或者草图任务环境中的Sketch Tools→Animate Dimension按钮[image: image94.emf]，打开Animate对话框，如图1-43所示。

[image: image95.emf]
图1-43  Animate对话框
动画尺寸选项描述如表1-2所示。

表1-2  动画尺寸选项描述

	选    项
	描    述

	Dimension list box（尺寸列表框）
	列出可以动态显示的尺寸

	Value（数值）
	当前选中尺寸的数值

	Lower Limit（下限值）
	动态显示中尺寸的最小值。默认值是选择的尺寸值减去它的10%

	Upper Limit（上限值）
	动态显示中尺寸的最大值。默认值是选择的尺寸值加上它的10%

	Steps/Cycle（步数/循环）
	从上限到下限移动时，尺寸值改变的步数（反之亦然）

	Display Dimensions（显示尺寸）
	可选项，动态显示中可以显示原始草图的尺寸


【练习1-6】  动态显示草图尺寸
本练习将尝试使用两种不同的方式改变尺寸值并且测试草图约束。

· 使用Dimensions对话框查看尺寸并进行尺寸调整，观察其对约束草图的影响。

· 使用Animate Dimension命令动态增加和减少尺寸值。

第1步  手工改变草图尺寸值。

· 打开\Parts_1\C1\animate_dimension.prt，启动建模应用模块。

· 在Part Navigator中的Sketch_000上单击鼠标右键，在弹出的快捷菜单中选择Edit with Rollback命令。

· 在Sketch Tools工具条上单击Inferred Dimension按钮[image: image96.png]


。

· 选择轮廓线右侧的竖直线进行标注，输入p14/2后，按Enter键确认，如图1-44所示。
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图1-44  调整草图尺寸

· 标注水平线到顶部圆心的距离，如图1-45所示。

· 在Sketch Tools工具条上单击Circle按钮[image: image98.png]


，在如图1-46所示中心处创建圆弧。

[image: image99.png]


           [image: image100.png]2/v19:519





图1-45  标注尺寸                              图1-46  创建圆弧曲线

· 按Esc键关闭圆弧对话框。

· 双击p14尺寸。

· 在Dimensions对话框中单击Sketch Dimension Dialog按钮[image: image101.png]


，如图1-47所示。

· 移动Value滑块，观察部件变化。
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图1-47  手工调整尺寸对话框

[image: image103.emf]
注意：若p15等于p14的一半，当拖动滑块时草图曲线会伸缩。
若p16独立于p14，草图轮廓在扩展和收缩时，草图曲线长度维持不变。

圆弧没有相对于草图曲线进行约束，保持在原位。

· 在Dimensions对话框中单击Close按钮。

· 撤销草图尺寸编辑，在图形工作区单击鼠标右键，并在弹出的快捷菜单中选择undo命令。

第2步  草图尺寸动画调整。

[image: image104.wmf]
提示：约束圆弧中心到两曲线，使用Animate Dimension改变值p14。

· 在Sketch Tools工具条上单击Constraints按钮[image: image105.png]


。

· 单击圆弧中心和竖直线，单击Midpoint按钮[image: image106.png]


。

· 单击圆弧中心和草图底部直线，单击Midpoint按钮[image: image107.png]


。

· 在Sketch Tools工具条上单击Animate Dimension按钮[image: image108.png]


。

· 在尺寸列表中单击p14，设置Lower Limit为130，Upper Limit为150，Steps/Cycle为6，然后单击Apply按钮。

[image: image109.emf]
注意：增加Steps/Cycle的值（即循环次数），将减慢动态显示速度。

NX在设置的表达式范围内动态显示草图。

由于圆弧与草图曲线的中点存在约束，因此它会随着曲线伸缩。

· 在动画尺寸窗口中单击Stop按钮，如图1-48所示。
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图1-48  动画尺寸窗口

[image: image111.emf]
注意：NX停止动画后，p14没有改变，仍维持原始数值。

Animate Dimension可以动态地查看尺寸在某一范围内变化时草图曲线的状态，对设计方案的修改起到辅助指导作用。

1.6  草图定位技术

可以利用基准轴、基准平面、属于其他草图的对象、非草图曲线或实体边缘来定位在当前激活草图平面中的草图。
用于草图中的定位方法支持由用户自定义特征（User Defined Features）或复制/粘贴特征（Copy/Paste）命令使用的草图。

定位草图可用下面两种方法之一：

· 草图约束或尺寸。

· 定位尺寸。

[image: image112.emf]
注意：这两种方法是互相排斥的。若用Positioning Dimensions（定位尺寸）建立草图尺寸或约束时不能引用外部对象。建立草图尺寸或约束时，若引用了外部对象，则不能使用定位尺寸。
[image: image113.png]


 警告：如果需要引用草图外部对象，不可以将草图尺寸、几何约束与定位尺寸组合使用。如果尝试在草图上建立约束到外部对象的定位尺寸，将出现图1-49所示的错误信息。

[image: image114.emf]
图1-49  错误信息

[image: image115.emf]
注意：只能选择Timestamp（时间戳记）次序较早的特征（有一个低时间戳记的数字）来约束草图。
为了观察已有定位尺寸，可选择Tools→Positioning Dimensions命令。
【练习1-7】  使用草图定位尺寸

[image: image116.emf] 设计意图：要求创建的草图作为用户自定义特征（UDF）。在应用UDF时，可以方便地进行特征定位和对齐。首先，使用完全约束草图；其次，用灵活的定位尺寸代替此实体特有的约束，如图1-50所示。

第1步  打开部件文件\Parts_1\C1\position_1.prt，如图1-51所示，启动建模应用模块。

[image: image117.emf]                    [image: image118.png]



 图1-50  使用定位尺寸                        图1-51  position_1.prt
第2步  考察已有特征及它们之间的关系。

· 单击Part Navigator，如图1-52所示。
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图1-52  部件导航树
第3步  打开SKETCH_000进行编辑。

· 双击SKETCH_000草图。如果没有进入草图任务环境，请设置Preferences→Modeling，然后设置Edit Sketch Action为Task Environment。

· 单击Show All Constraints按钮[image: image121.png]


，如图1-53所示。

[image: image122.emf]
注意：有两个垂直、一个水平和两个相切的约束。

第4步  利用尺寸约束定位SKETCH_000草图到部件的平表面上。

· [image: image165.png]


单击Inferred Dimensions按钮[image: image123.png]


。
· 选择圆弧中心和实体的底面水平边缘，[image: image166.png]


放置垂直尺寸到零件的右面，设置其值为3，并按Enter键确认，如图1-54所示。
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 图1-53  显示所有约束                        图1-54  使用尺寸约束来定位草图
[image: image126.emf]
注意：状态行显示还需要一个约束，草图上不再出现垂直的DOF。

· [image: image167.png]


选择弧中心和实体右面的垂直边缘，[image: image168.png]


在零件上放置水平尺寸，[image: image169.png]


设置其值为2，并按Enter键确认，如图1-55所示。

[image: image170.png]


[image: image127.png]



图1-55  草图已完全约束
[image: image128.emf]
注意：现在草图已经充分约束。

第5步  测试草图，查看在当前的约束状态下是否可以添加更多灵活的定位尺寸。

[image: image129.emf] 设计意图：某些情况下，草图需要旋转20度，如图1-56所示。

· 在Inferred Dimensions列表中单击Angular按钮[image: image130.png]A



。

· 按[image: image171.png]


如图1-57所示的位置及次序选择对象，放置尺寸到零件的右边。
[image: image131.png]
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图1-56  草图需要旋转20度                         图1-57  添加角度尺寸
[image: image133.emf]
注意：角度尺寸和水平约束已经以过约束色显示，而且状态行显示草图是过约束（over constrained）状态。

· 单击Undo按钮[image: image134.png]


。

第6步  删除利用部件实体边缘建立的两个草图尺寸，然后添加一固定约束到草图的左下拐角，准备创建定位尺寸。

[image: image135.emf]
注意：可在草图工具栏中添加定位尺寸图标[image: image136.png]


，或使用Tools→Positioning Dimensions命令。

· 选择Tools→Positioning Dimensions→Create命令[image: image137.png]


。
[image: image138.png]


 警告：当草图与外部对象有约束关系时会弹出错误窗口，如图1-58所示，提示不能使用定位尺寸，除非删去草图与外部对象的约束。
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图1-58  错误警告：不能建立定位尺寸
· [image: image172.png]


单击OK按钮。

[image: image140.emf] 设计意图：可以删去草图与实体的尺寸约束，并用定位尺寸代替。在以后的用户自定义特征中，创建草图引用特征的用户可以用相似的定位尺寸来满足设计意图。

· 在图形窗口中，选择两个利用实体边缘建立的草图尺寸。

· [image: image173.png]


单击Delete按钮[image: image141.png]


。
· [image: image174.png]


单击Constraints按钮[image: image142.png]


。
· [image: image175.png]


选择如图1-59所示的端点[image: image143.png]


，并应用一个Fixed约束[image: image144.png]


。
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图1-59  在左下端点处添加Fixed 约束
[image: image146.emf]
注意：如果草图曲线变为全约束的颜色，则所有自由度符号就没有了。现在，草图是全约束的，且没有外部参考。

当使用定位功能（Positioning Dimensions）时将作用到整个草图。

第7步  利用两个正交定位尺寸来定义从弧中心到部件的底部水平边缘与右侧的垂直边缘的距离。

· [image: image176.png]


选择Tools→Positioning Dimensions→Create命令[image: image147.png]


。
· [image: image177.png]


单击Perpendicular按钮[image: image148.png]


。
· [image: image178.png]


选择实体底部的水平边缘。

· [image: image179.png]


选择弧并单击Arc Center。

· [image: image180.png]


单击OK按钮并接受值3。

· [image: image181.png]


单击Perpendicular按钮[image: image149.png]


。
· [image: image182.png]


选择实体右侧的垂直边缘。

· [image: image183.png]


选择弧并单击Arc Center。
· [image: image184.png]


单击OK按钮并接受值2。

第8步  在部件的底部水平边缘与草图的底部水平线间建立一个角度尺寸。

· [image: image185.png]


单击Angular按钮[image: image150.png]A



。

· [image: image186.png]


在如图1-60所示的位置，按次序[image: image151.emf]、[image: image152.emf]选择对象。
[image: image153.png]



图1-60  按次序选择对象
· [image: image187.png]


在Create Expression对话框中设置角度为20，并单击OK按钮。

[image: image154.emf]
注意：草图将旋转20度，即使添加了垂直和水平尺寸约束。这是因为定位尺寸将整个草图作为一个特征操作。

第9步  可选项：编辑角度定位尺寸从20到45。

· [image: image188.png]


选择Tools→Positioning Dimensions→Edit命令[image: image155.png]


。
· [image: image189.png]


在图形窗口中选择角度定位尺寸。

· 设置其值为45，并单击两次

· OK按钮。

· [image: image190.png]


单击Finish Sketch按钮[image: image156.png]


，退出草图。
第10步  关闭部件文件。
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